RAID
User Guide
Product notice

This user guide describes features that are common to most models. Some features may not be available on your computer.
# Table of contents

1 Introduction

2 RAID technology overview
   RAID terminology ................................................................. 2
   RAID modes supported .......................................................... 3
   The advantages of RAID modes supported ............................ 5

3 Operating systems and devices supported
   Operating systems supported .................................................. 6
   Devices supported ................................................................. 6

4 Intel Matrix Storage Manager features
   Advanced Host Controller Interface ......................................... 9
   Intel Rapid Recover Technology ............................................. 10

5 RAID volume setup
   Enable RAID through the system BIOS (f10) ............................... 12
   Initiate RAID migration using Intel Matrix Storage Console ......... 14
   Using Intel Matrix Storage Console IRRT features .................. 24

6 Resetting RAID drives to non-RAID

7 Frequently asked questions
   Can more than one RAID volume be installed on a computer? ........ 29
   Is Matrix RAID supported to allow both RAID 0 and RAID 1 on a single RAID volume? ............ 29
   Can the computer be undocked if the recovery HDD is in the docking station SATA swappable bay? ................................................................. 29

Index .......................................................................................... 30
Until recently, there were limited options for most notebook PC users who wanted to protect their data from loss in the event of a hard drive failure. These options were; manually copying files to a backup drive or using cumbersome backup software. If users failed to perform one of these mundane tasks prior to a hard drive failure, they had to spend considerable time and money to recover even a portion of the data on the drive. Server and desktop computer users have long enjoyed the security and benefits of RAID (Redundant Array of Independent Disk’s) technology to recover data in the event of drive failure.

HP now offers a simple RAID solution for notebook computer users who need to protect data on a Serial ATA (SATA) disk drive in case of drive failure or virus attacks. HP’s RAID solution will also benefit notebook PC users who frequently work with large files and want to improve the storage performance of their computer.

NOTE: The illustrations in this guide are provided in English only.
This chapter defines the terms used in this guide and describes the RAID technologies supported by select HP Business Notebook PCs.

**RAID terminology**

Some of the terms in the following table have a broader meaning, but they are defined in relation to the RAID implementation described in this guide.

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fault tolerance</td>
<td>The ability of the computer to continue to operate if one drive fails. Fault tolerance is often used interchangeably with reliability, but the two terms are different.</td>
</tr>
<tr>
<td>HDD</td>
<td>One physical Hard Disk Drive in the RAID array.</td>
</tr>
<tr>
<td>Option ROM</td>
<td>A software module inside the system BIOS that provides extended support for a particular piece of hardware. The RAID option ROM provides boot support for RAID volumes as well as a user interface for managing and configuring the systems RAID volumes.</td>
</tr>
<tr>
<td>Primary drive</td>
<td>The main internal HDD in the notebook PC.</td>
</tr>
<tr>
<td>RAID array</td>
<td>The physical drives that appear as one logical drive to the operating system.</td>
</tr>
<tr>
<td>RAID migration</td>
<td>The change of data from a non-RAID to RAID configuration. “RAID level migration,” or the change of data from one RAID level to another, is not supported.</td>
</tr>
<tr>
<td>RAID volume</td>
<td>A fixed amount of space across a RAID array that appears as a single HDD to the operating system.</td>
</tr>
<tr>
<td>Recovery drive</td>
<td>The hard drive that is the designated mirror (copy of the primary) drive in a RAID 1 and IRRT volume.</td>
</tr>
<tr>
<td>Reliability</td>
<td>Reliability refers to the likelihood—over a period of time—that a HDD can be expected to operate without failure, also known as mean time before failure (MTBF).</td>
</tr>
<tr>
<td>Stripe</td>
<td>Set of data on a single hard drive in a RAID volume.</td>
</tr>
<tr>
<td>Striping</td>
<td>Striping is the distribution of data over multiple disk drives to improve read/write performance.</td>
</tr>
</tbody>
</table>
RAID modes supported

The RAID modes supported by HP Business Notebook PCs include RAID 0, RAID 1, and Intel® Rapid Recover Technology (RAID 1 enhanced) as described below. Each RAID mode requires two SATA HDDs. This can be accomplished by inserting a second SATA hard drive into the Upgrade Bay or eSATA port (if available) of the notebook PC, or in the SATA swappable bay of the HP Advanced Docking Station (see Devices supported on page 6). RAID 5 and RAID 10 are not supported.

RAID 0

RAID 0 stripes, or distributes, data across both drives. This allows data, especially large files, to be read faster because data is read simultaneously from both drives. However, RAID 0 offers no fault tolerance; which means that the entire array fails if one drive fails.

RAID 1

RAID 1 copies, or mirrors, identical data on two HDDs. If one HDD fails, RAID 1 allows data to be recovered from the other HDD.

Intel® Rapid Recover Technology

Intel Rapid Recover Technology (IRRT) is a feature of Intel® Matrix Storage Manager software. IRRT enhances RAID 1 functionality with several features that make it easier for users to mirror data to a designated recovery drive. For example, IRRT allows users to determine how the recovery volume is updated, either continuously or on request. IRRT also enables docking and undocking of the computer if the recovery drive is in the docking station bay.

RAID mode summary

The following table describes the function, applications, and the advantages and disadvantages of the supported RAID modes.

<table>
<thead>
<tr>
<th>RAID LEVELS</th>
<th>Function/Applications</th>
<th>Advantages/Disadvantages</th>
</tr>
</thead>
<tbody>
<tr>
<td>RAID 0</td>
<td>Function:</td>
<td>Advantages:</td>
</tr>
<tr>
<td></td>
<td>Data is distributed across both disk drives.</td>
<td>Read performance is higher than that of a non-RAID HDD.</td>
</tr>
<tr>
<td></td>
<td>Applications:</td>
<td>Total storage capacity is doubled.</td>
</tr>
<tr>
<td></td>
<td>● Image editing</td>
<td>Disadvantages:</td>
</tr>
<tr>
<td></td>
<td>● Video production</td>
<td>The entire array fails if one drive fails; data cannot be recovered.</td>
</tr>
<tr>
<td></td>
<td>● Pre-press applications</td>
<td>Storage space may be wasted if the capacities of the primary and recovery HDDs are different (see HP SATA drive option kits on page 6).</td>
</tr>
<tr>
<td>RAID 1</td>
<td>Function:</td>
<td>Provides high fault tolerance.</td>
</tr>
<tr>
<td></td>
<td>Identical (mirrored) data is stored on two drives.</td>
<td></td>
</tr>
<tr>
<td>RAID LEVELS</td>
<td>Function/Applications</td>
<td>Advantages/Disadvantages</td>
</tr>
<tr>
<td>-------------</td>
<td>-----------------------</td>
<td>--------------------------</td>
</tr>
<tr>
<td><strong>Applications:</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>● Accounting</td>
<td></td>
<td>Only half of the total drive capacity can be used for storage.</td>
</tr>
<tr>
<td>● Payroll</td>
<td></td>
<td>Storage space may be wasted if the capacities of the primary and recovery HDDs are different (see <strong>HP SATA drive option kits</strong> on page 6).</td>
</tr>
<tr>
<td>● Financial</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>RAID IRRT</th>
<th>Function:</th>
<th>Advantages:</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Function:</strong></td>
<td></td>
<td>Provides high fault tolerance.</td>
</tr>
<tr>
<td>Identical (mirrored) data is stored on two drives.</td>
<td></td>
<td>Users can choose to mirror data continuously or on request.</td>
</tr>
<tr>
<td>Boosts the functionality of RAID 1 with valuable features.</td>
<td></td>
<td>Data recovery is quick and easy.</td>
</tr>
<tr>
<td><strong>Applications:</strong></td>
<td></td>
<td>Allows hot-plugging of mirrored drive (with eSATA or docking station HDD).</td>
</tr>
<tr>
<td>Any application that requires a simple data protection method.</td>
<td></td>
<td>Enables easy migration to non-RAID.</td>
</tr>
</tbody>
</table>

**Disadvantages:**

- Only half of the total drive capacity can be used for storage.
- Storage space may be wasted if the capacities of the primary and recovery HDDs are different.
The advantages of RAID modes supported

Fault tolerance and performance are important terms to understand when choosing a RAID mode.

Fault tolerance

Fault tolerance is the ability of a RAID array to withstand and recover from a drive failure. Fault tolerance is provided by redundancy. Therefore, RAID 0 has no fault tolerance because it does not copy data to another HDD. With RAID 1 and IRRT, one drive can fail without causing the array to fail. With IRRT, however, recovery of a single file or an entire HDD is much simpler than using RAID 1 alone.

Performance

Performance is easy to understand, but it is difficult to measure because it involves several factors, some of which are beyond the scope of this document. Overall storage performance is determined by write performance and read performance, both of which vary based on the RAID technology selected.

- RAID 0 (striping) improves overall storage performance because data can be written and read simultaneously across two HDDs.
- IRRT and RAID 1 (mirroring) writes the same data to both HDDs; therefore, write performance may be slower. However, data can be read from both HDDs, so the read performance can be higher than that of a single non-RAID HDD.
3 Operating systems and devices supported

Operating systems supported

HP RAID supports 32-bit and 64-bit versions of Microsoft® Windows® XP Professional (SP1, SP2, and SP3), Windows Vista® (SP1 and SP2), and Windows 7 operating systems.

Devices supported

This section describes the devices supported for RAID migration, including the SATA drives, computers, and docking station. Device support is summarized in the following table and then explained in more detail below the table. External USB 2.0 SATA drives connected to the computer or docking station cannot be used for migrating to RAID.

<table>
<thead>
<tr>
<th>RAID</th>
<th>Primary and Upgrade Bay SATA HDDs in the computer</th>
<th>Docking station HDD or eSATA HDD attached to computer</th>
</tr>
</thead>
<tbody>
<tr>
<td>RAID 0</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>RAID 1</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>IRRT</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

HP SATA drive option kits

HP offers SATA drive option kits for the notebook PC Upgrade Bay and the docking station SATA swappable bay to support RAID migration. For optimal RAID performance, it is recommended that both drives have the same speed. However, supported HP Business Notebook PCs allow drives with different speeds to be used in a RAID volume.

Drives of different capacities are also supported for RAID migration, as long as the capacity of the secondary (recovery) drive is equal to or greater than that of the primary drive. For example, if the primary drive is 200 GB, then at least a 200-GB drive is required in the Upgrade Bay to create a RAID volume. If the capacity of the secondary drive is larger than that of the primary drive, the excess capacity of the secondary drive will not be accessible. If, for example, the primary drive is 160 GB and the secondary drive is 250 GB, only 160 GB of the secondary drive will be usable in a RAID configuration. Therefore, for optimal use, it is recommended that both drives have the same capacity.
eSATA HDDs (select models only)

External SATA, or eSATA, is an external interface that allows a SATA drive to achieve data transfer speeds up to 6 times that of a SATA drive using a standard USB 2.0 interface. The following illustration shows a supported notebook PC with a primary HDD (1) and an eSATA drive (2) connected to the eSATA port (select models only) to allow RAID IRRT. Regarding the capacity of the eSATA drive, the same recommendations apply as stated for secondary drives in the notebook PC Upgrade Bay.

HP Business Notebook PCs

Select HP Business Notebook PCs support RAID using Intel® Matrix Storage Manager software (v8.0.2 and higher) and a secondary SATA drive in the Upgrade Bay.

The following illustration shows a supported notebook PC with the primary HDD (1) and a secondary SATA drive in the Upgrade Bay (2) that allow RAID 0, RAID 1, and IRRT.
HP Advanced Docking Station

IRRT supports docking and undocking. It can be used to implement mirroring between the primary HDD (1) and an optional HDD in the SATA swappable bay of the HP Advanced Docking station (2).

The following illustration shows an HP Advanced Docking Station with the recovery HDD in the SATA swappable bay that allows IRRT.
The Intel Matrix Storage Manager supports the following features.

**Advanced Host Controller Interface**

The Advanced Host Controller Interface (AHCI) is a specification that allows the storage driver to enable advanced SATA features such as Native Command Queuing and hot plug capability. AHCI must be enabled in the system BIOS for these features to apply (see Enable RAID through the system BIOS (f10) on page 12). AHCI is enabled by default on supported HP Business notebook PCs.

**Native Command Queuing**

A read/write drive head writes data to an HDD platter in concentric circles (tracks) based on the order in which the write request was received. Because applications rarely request data in the same order that it was written to the platter, long delays (latency) would result if the drive head had to locate data in the exact order that the HDD receives read requests. Native Command Queuing (NCQ) allows SATA HDDs to accept multiple commands and change their execution order to improve performance. This is analogous to the way an elevator reorders floor requests to minimize travel time and mechanical wear. Similarly, NCQ reduces the latency and unnecessary drive head movement required to execute multiple outstanding read/write requests, resulting in increased performance and reliability. NCQ requires support from the system BIOS, SATA controller, and controller driver.

**Hot plug capability**

Hot plug capability allows the SATA recovery HDD to be removed or inserted while the notebook PC is running. Hot plug capability is supported when the recovery HDD is connected to the eSATA port or located in the docking station SATA swappable bay. For example, the recovery HDD in the docking station SATA swappable bay can be removed while the notebook PC is running if you need to temporarily insert an optical drive in the bay. Hot plug capability also allows you to dock and undock the computer at any time.
**Intel Rapid Recover Technology**

Intel Matrix Storage Manager supports the following IRRT features.

**Mirror update policies**

With IRRT, you can determine how often the mirror HDD is updated: continuously or on-request. When using the continuous update policy, data on the primary drive is simultaneously copied to the mirror drive as long as both drives are connected to the system. If you undock the computer while using the docking station recovery drive, all new or revised data on the primary HDD is automatically copied to the recovery HDD when the notebook is re-docked. This policy also allows for an unfinished mirroring operation to be completed if it was interrupted when you undocked the notebook.

When using the update on request policy, data on the primary HDD is copied to the mirror HDD only when you request it by selecting **Update Recovery Volume** in IRRT. After the request, only the new or updated files on the primary drive are copied to the mirror HDD. Prior to updating the mirror HDD, the on-request policy allows a file to be recovered if the corresponding file on the primary HDD is corrupted. The on-request policy can also protect data on the mirror HDD if the primary HDD is attacked by a virus, provided you do not update the mirror HDD after the virus attack.

**NOTE:** You can change the mirror update policy at any time by right-clicking **Modify Volume Update Policy**.

**Automatic HDD switching and rapid recovery**

If the primary HDD fails, IRRT automatically switches to the mirrored drive without user intervention. IRRT displays a message to notify you of the primary HDD failure. In the meantime, the computer can boot from the mirrored HDD. When a new primary HDD is installed and the computer is booted, IRRT’s rapid recovery feature copies all mirrored data to the primary HDD.

**NOTE:** If using the update on request policy and the primary HDD fails or a file on the primary HDD becomes corrupted, all unmirrored data is lost.

**Simplified migration from RAID to non-RAID**

Users can migrate from a RAID 1 or IRRT volume to two non-RAID HDDs, called “breaking the array,” by following the instructions in **Resetting RAID drives to non-RAID on page 27**.

Migration from RAID 1 to IRRT is also supported. However, migration from RAID 0 to RAID 1 or from RAID 0 to a non-RAID primary HDD is not supported.
5 RAID volume setup

The following instructions assume that a supported HDD is installed in the computer Upgrade Bay, in the SATA swappable bay of the docking station, or connected to the eSATA port of the notebook PC (see Devices supported on page 6).

The basic RAID migration steps are as follows:

● Enable RAID through the system BIOS.
● Initiate RAID migration using the Intel® Matrix Storage Console.

⚠️ CAUTION: Make sure that the notebook PC is connected to AC power before initiating the following procedures. The loss of power during RAID migration can result in the loss of data.
Enable RAID through the system BIOS (f10)

**NOTE:** The following procedures assume that you are using the HDD image that shipped with your computer. If a different image is installed on your computer, you must first enable RAID through the system BIOS (f10), and then install the operating system and all required drivers, including the Intel Matrix Storage driver. Then follow the steps in [Initiate RAID migration using Intel Matrix Storage Console on page 14](#).

Users must enable RAID capability through the system BIOS to switch the SATA host controller for RAID. The steps are as follows:

1. Turn on the computer, or restart it.
2. Press f10 as soon as the computer boots.
   
   If you do not press f10 at the appropriate time, you must restart the computer, and then press f10 again to access the utility.

3. In the system BIOS, select System Configuration > Device Configurations.
4. In the Device Configurations window, select RAID to the right of SATA Device Mode. Click Yes when the message displays: “Changing this setting may require reinstallation of your operating system. Are you sure you want to proceed?”

**NOTE:** The HDD image supplied with your notebook PC contains drivers that allow you to switch between AHCI and RAID modes without reinstalling the operating system. If you use a different HDD image, you may need to reinstall the operating system.

5. Select File > Save Changes and Exit. Then, click Yes to save the changes. If you do not want to apply your changes, select Ignore Changes and Exit.

⚠️ **CAUTION:** Do NOT turn the computer power off while the ROM is saving the f10 Computer Setup changes as the Complementary Metal Oxide Semiconductor (CMOS) could become corrupted. Only turn the computer off after exiting the f10 Setup screen.

6. After the operating system boots, you can begin the RAID migration procedure.
Initiate RAID migration using Intel Matrix Storage Console

1. Open the Intel Matrix Storage Console (Console) by selecting Start > All Programs > Intel Matrix Storage Manager > Intel Matrix Storage Console.

**NOTE:** Windows Vista includes the User Account Control feature to improve the security of your computer. You may be prompted for your permission or password for tasks such as installing software, running utilities, or changing Windows settings. Refer to Windows Help for more information.

The Console starts in Basic mode, displaying the status of the installed drives. The available RAID levels are based on the location of the secondary HDD. For example, when the secondary drive is in the notebook PC Upgrade Bay, all three RAID options are available as shown.

When the secondary HDD is in the docking station bay or connected to the eSATA port of the notebook PC (select models only), IRRT is the only RAID option available.

2. When you select an available RAID level in the left pane, a description displays in the right pane. After you choose the best RAID level for your application, follow the appropriate instructions in one
of the following sections. If you are an advanced user and prefer more options, refer to Intel Matrix Storage Console advanced features on page 22.

**Migrating to RAID 1**

1. In the left pane, select Protect data from a hard drive failure with RAID 1, and then click the icon beside Create a RAID 1 volume in the right pane. When the confirmation message displays, click Yes to begin the migration, or click No to cancel the migration.

2. The progress of the RAID 1 migration displays in a separate window. You can minimize the Console and progress windows and use the computer during the migration process.
3. The hard drive and volume status display after the migration is complete.

4. Close the Console window, save any open files, and reboot the computer.

**Migrating to RAID 0**

**NOTE:** Migrating to RAID 0 requires you to perform additional advanced steps, which includes copying data to an additional external USB HDD. Please read the entire RAID 0 migration procedure before you begin.

1. In the left pane, select **Improve storage performance with RAID 0**, and then click the icon beside **Create a RAID 0 volume** in the right pane. When the confirmation message displays, click **Yes** to begin the migration, or click **No** to change to a different RAID volume.
2. The progress of the RAID 0 migration displays in a separate window. You can minimize the Console and progress windows and use the computer during the migration process.

![Migration Progress](image)

3. Click **Yes** to reboot the system when prompted after the volume creation is complete.

![Reboot Confirmation](image)

**NOTE:** Although the total capacity of the RAID 0 volume appears in the Console, the extra capacity created with the addition of the secondary HDD appears as unallocated space to the system. After the system reboots, you will need to allocate the unallocated space. For Windows XP, the only option through the operating system is to create and format a separate volume. Windows Vista contains some additional capabilities that allow you to create a single RAID 0 volume.

### Allocating unallocated HDD space

After the system reboots, you will need to allocate the unallocated space. You can create an additional partition or you can extend the (C:) partition. In order to extend the (C:) partition, you will need to move the Extensible Firmware Interface (EFI) and Recovery partitions using the following procedure. The EFI partition stores QuickLook, system diagnostics, and BIOS Flash Recovery files. The Recovery partition contains files that allow you to restore the computer to the factory image.

**NOTE:** If the functionality of the EFI and Recovery partitions is not required, these partitions can be deleted.

In Windows XP:

1. After the system reboots, select **Start**, right-click **My Computer**, and then click **Manage** from the drop-down menu.

2. In the left pane under **Storage**, click **Disk Management**. The Disk Management window displays Unallocated space and two partitions—(C:) and HP_TOOLS.

3. Right-click the **Unallocated** capacity, and then select **New Partition** from the drop-down menu. The New Partition Wizard opens.
4. Click **Next**.

5. Select **Primary Partition**, and then click **Next**.
   The partition size defaults to the maximum.

6. Click **Next**.

7. Assign a drive letter, and then click **Next**.

8. Select the **NTFS** format, enter the volume name, and then click **Next**.

9. Review your selections, and then click **Finish** to complete the formatting.

In Windows Vista and Windows 7:

1. Select **Start**, right-click **Computer**, and then click **Manage** from the drop-down menu. The Computer Management window displays.

2. In the left pane under Storage, click **Disk Management**. The Disk Management window displays Unallocated space and three partitions—(C:), HP_TOOLS, and HP_RECOVERY.

   **NOTE:** The drive letters may vary depending on your system configuration.

3. Connect an external USB drive with at least 10 GB of free capacity to a USB port on the computer.

4. Open Windows Explorer, and then select the primary drive (C:).

5. Select **Organize > Folder and Search Options**.

6. Click the **View** tab.

7. Under **Hidden files and folders**, select the radio button next to **Show hidden files and folders**.

8. Uncheck the box next to **Hide Protected Operating System Files**, and then click **OK**.

9. Select the **HP_RECOVERY** partition in the left pane, and then copy its contents (\boot, \sources, \system.save, bootmgr, and HP_WINRE) to the external USB drive. If the Destination Folder Access Denied window displays, click **Continue** to copy the file. If the User Account Control window displays, click **Continue**.

10. Select the **HP_TOOLS** partition in the left pane, and then copy its contents (Hewlett-Packard) to the USB drive.

11. Return to the Disk Management window and select the **HP_RECOVERY** partition. Then click the delete icon in the menu bar. Repeat this procedure for the HP_TOOLS partition. The amount of unallocated capacity increases.

12. Right-click the (C:) drive, and then click **Extend Volume** from the drop-down menu. The Extend Volume Wizard opens.

13. Click **Next**.
14. The amount of unallocated capacity (in MB) available to extend the (C:) drive is displayed next to **Select the amount of space in MB**. Subtract 10240 MB, which is equivalent to 10 GB, from the number displayed. For example, if 67584 MB (or 66 GB) is displayed, subtract 10240 MB to calculate 57344 MB (or 56 GB). Then replace the display capacity with the calculated capacity or press the down arrow until the calculated number appears.

15. Click **Next**, and then click **Finish**. The new RAID 0 volume capacity and 10 GB of unallocated capacity displays in the Disk Management window.

16. Create the HP_TOOLS partition as follows:
   a. Right-click the **Unallocated** capacity, and then click **New Simple Volume** from the drop-down menu. The New Simple Volume Wizard opens.
   b. Click **Next**.
   c. Enter 1024 MB in the space provided, and then click **Next**.
   d. Select the drive letter (E:), and then click **Next**.
   e. Select **FAT32** as the File System. To the right of Volume label, enter the name **HP_TOOLS**.
   f. Click **Next**, and then click **Finish**.

17. Repeat the previous step to assign the drive letter (D:) to the remaining 9 GB of Unallocated capacity. Then format the partition as **NTFS** and name it **HP_RECOVERY**.

18. In Windows Explorer, copy the contents of the HP_TOOLS and HP_RECOVERY from the USB drive to the respective partitions.

19. In order for the HP Recovery functionality to work correctly (F11 during POST), the Boot Configuration Data (BCD) needs to be updated. The following commands need to be run in Administrator mode. It is recommended that a batch file (*.bat) is created with these commands and run rather than typing them in individually.

   **NOTE:** The commands assume the HP_RECOVERY partition is drive (D:). If it is different, replace D with the correct drive letter.

   ```bash
   BCDEDIT.EXE -store D:\Boot\BCD -create {ramdiskoptions} -d "Ramdisk Options"
   BCDEDIT.EXE -store D:\Boot\BCD -set {ramdiskoptions} ramdisksdidevice partition=D:
   BCDEDIT.EXE -store D:\Boot\BCD -set {ramdiskoptions} ramdisksdipath \boot\boot.sdi
   BCDEDIT.EXE -store D:\Boot\BCD -create {572bcd55-ffa7-11d9-aae0-0007e994107d} -d "HP Recovery Environment" -application OSLOADER
   BCDEDIT.EXE -store D:\Boot\BCD -set {572bcd55-ffa7-11d9-aae0-0007e994107d} device ramdisk=[D:\]sources\winre.wim,{ramdiskoptions}
   BCDEDIT.EXE -store D:\Boot\BCD -set {572bcd55-ffa7-11d9-aae0-0007e994107d} path \windows\system32\boot\winload.exe
   ```

Initiate RAID migration using Intel Matrix Storage Console 19
BCDEdit.exe -store D:\Boot\BCD -set \{572bcd55-ffa7-11d9-aae0-0007e994107d\} osdevice
ramdisk=[D:\sources\winre.wim],\{ramdiskoptions\}

BCDEdit.exe -store D:\Boot\BCD -set \{572bcd55-ffa7-11d9-aae0-0007e994107d\} systemroot \windows

BCDEdit.exe -store D:\Boot\BCD -set \{572bcd55-ffa7-11d9-aae0-0007e994107d\} winpe yes

BCDEdit.exe -store D:\Boot\BCD -set \{572bcd55-ffa7-11d9-aae0-0007e994107d\} detecthal yes

BCDEdit.exe -store D:\Boot\BCD -set \{572bcd55-ffa7-11d9-aae0-0007e994107d\} nx optin

BCDEdit.exe -store D:\Boot\BCD -set \{572bcd55-ffa7-11d9-aae0-0007e994107d\} custom: 46000010 yes

BCDEdit.exe -store D:\Boot\BCD -create \{bootmgr\} /d "Windows Boot Manager"

BCDEdit.exe -store D:\Boot\BCD -set \{bootmgr\} device boot

BCDEdit.exe -store D:\Boot\BCD -set \{bootmgr\} displayorder \{default\}

BCDEdit.exe -store D:\Boot\BCD -set \{bootmgr\} default \{572bcd55-ffa7-11d9-aae0-0007e994107d\}

BCDeEdit.exe -set \{ramdiskoptions\} ramdisk.sdidevice partition=D:

BCDeEdit.exe -set \{572bcd55-ffa7-11d9-aae0-0007e994107d\} device ramdisk=[D:\sources \winre.wim],\{ramdiskoptions\}

BCDeEdit.exe -set \{572bcd55-ffa7-11d9-aae0-0007e994107d\} osdevice ramdisk=[D:\sources \winre.wim],\{ramdiskoptions\}

BCDeEdit.exe -set \{default\} recoverysequence \{572bcd55-ffa7-11d9-aae0-0007e994107d\}

BCDeEdit.exe -set \{default\} recoveryenabled yes

20. After the batch file is created, in Windows Explorer, right-click the file and select Run as Administrator. The batch file will execute.

21. Restart the computer.
Migrating to IRRT

IRRT offers more control over how data is copied from the primary drive to the recovery drive. When the secondary HDD is in the docking station SATA swappable bay or connected to the eSATA port of the notebook PC (select models only), IRRT is the only RAID option available.

1. Select **Protect data using Intel® Rapid Recover Technology** in the left pane, and then click the icon beside **Create a recovery volume** in the right pane. When the confirmation message displays, click **Yes** to begin the migration, or click **No** to change to a different RAID volume.

2. The MSM software runs in the background while creating the RAID volume. You can minimize the Console window and use the computer during the migration process.
3. After the RAID migration is complete, a notification message displays. The Console window displays the volume status.

4. It is recommended that you reboot the computer after the RAID volume is created.

**Intel Matrix Storage Console advanced features**

This optional configuration procedure is available for advanced users.

1. For a more detailed view of the RAID controller and the SATA HDDs present in the system, select **View > Advanced Mode**. The left pane, also called the device pane, shows the logical and physical views of the available drives.

2. In Advanced Mode, the Console also includes the Actions menu, which can be used to access advanced RAID options that allow you to manually configure a RAID or recovery volume.
3. Selecting one of the Action options opens the Create Recovery Volume Wizard, which allows you to select the primary (master) drive and the secondary (recovery) drive. Select Help > Contents and Index, or press f1 for more information.

![Create RAID Volume from Existing Hard Drive Wizard](image)

Welcome to the Create RAID Volume from Existing Hard Drive Wizard
This wizard migrates data from a single non-RAID hard drive to a new RAID volume.
Volume migration can take up to two hours depending on the size of the hard drives being used.
You may continue to use other applications during this time.
Select ‘Next’ to continue.
Using Intel Matrix Storage Console IRRT features

Modifying the volume update policy

When using IRRT, you can select how often the recovery HDD is updated: continuously or on-request. Continuous Updates is the default update policy (see Mirror update policies on page 10). The steps to change the update policy to on-request are as follows:

1. Select **Modify Volume Update Policy** in the left pane. The current update policy is displayed in the right pane.

2. Select the icon beside **Disable Continuous Updates** in the right pane. The on-request update policy displays in Basic mode.

3. When using the on-request update policy, you can manually update the recovery volume by selecting **Update Recovery Volume** in the left pane, and then selecting the icon beside **Update Recovery Volume** in the right pane.
4. You can restore the continuous update policy at any time by selecting **Modify Volume Update Policy** and selecting the icon beside **Enable Continuous Updates**.

5. Close the Console.

**Accessing recovery drive files (IRRT only)**

When using IRRT, you can access the recovery drive to view the files in Windows Explorer. However, when you access the recovery drive files, the recovery volume can not be updated until you reenable the continuous update policy.

**NOTE:** When you access files on the recovery drive, the recovery drive status changes to read-only. You can only copy files from the recovery drive to the primary drive or to other storage media.

To access the recovery drive files:

1. Select **Access Recovery Drive Files** in the left pane, and then click the icon beside **Access Recovery Drive Files** in the right pane. A message displays that updates to the recovery volume will be disabled.
2. Click **OK** to confirm access to the recovery drive files. You can now open Windows Explorer to view the files. The update policy changes to on-request and the recovery volume flashes red in the Console window.

![Image of Intel Matrix Storage Console](image)

3. After you are finished viewing the files in Explorer, select **Modify Volume Update Policy** in the left pane, and then select the icon beside **Enable Continuous Updates** in the right pane.
You can reset a RAID 1 or IRRT volume to two non-RAID drives using the following instructions to access the Intel Option ROM and reset both drives to non-RAID status. You must also reset both drives to non-RAID if you need to move the RAID recovery drive from the notebook PC Upgrade Bay to the docking station bay.

**NOTE:** A RAID 0 volume cannot be migrated to a RAID 1 volume or to a non-RAID primary HDD because the size of the RAID 0 volume may be greater than the capacity of the primary HDD. If you wish to return the primary HDD in a RAID 0 volume to non-RAID status, you must first back up all data to an external drive with sufficient capacity. Then follow the steps below to reset the RAID 0 drives to non-RAID. After you complete the procedure, you must reinstall the operating system on the primary drive.

1. Power on or restart the computer. When the Option ROM window displays, press ctrl+i to enter the configuration utility.
2. In the Main Menu, use the up or down arrow key to select 3. **Reset Disks to Non-RAID**, and then press enter. The Reset RAID Data window displays.

3. Press the space bar to select the first drive, and then press the down arrow key and the space bar to select the second drive.

4. Press enter, and then press Y to confirm the selection.

5. Use the down arrow key to select 5. **Exit**, and then press enter and Y to boot the system.
Can more than one RAID volume be installed on a computer?

No, there can only be one RAID volume on a computer.

Is Matrix RAID supported to allow both RAID 0 and RAID 1 on a single RAID volume?

No.

Can the computer be undocked if the recovery HDD is in the docking station SATA swappable bay?

Yes. If the “Continuous update” policy is selected, data is automatically copied to the docking station recovery drive when the computer is re-docked. If the “Update on request” policy is selected, you must follow the normal procedure to copy data to the recovery HDD when the computer is re-docked.
Index

A
accessing recovery drive files 25
Advanced Host Controller Interface 9
automatic HDD switching and rapid recovery 10

D
devices supported 6

E
enabling RAID 12
eSATA HDDs 7

F
fault tolerance 2, 3, 4, 5
files, accessing recovery drive 25
frequently asked questions 29

H
HDD 2
hot plug 9
HP Advanced Docking Station 8
HP Business Notebook PCs 7
HP SATA drive option kits 6

I
initiating RAID migration 14
Intel Matrix Storage Console advanced features 22
Intel Matrix Storage Console IRRT features 24
Intel Matrix Storage Manager 9
Intel Rapid Recover Technology 3, 10
IRRT 3

M
migrating to IRRT 21
migrating to RAID 0 16

mirror update policies 10
mirroring 5
modes 3
modifying the volume update policy 24

N
Native Command Queuing 9

O
operating systems supported 6
option ROM 2, 27

P
performance 5
primary drive 2

R
RAID 0 3
RAID 1 3
RAID array 2, 5
RAID migration 2, 6, 11, 14
RAID terminology
fault tolerance 2
HDD 2
option ROM 2
primary drive 2
RAID array 2
RAID migration 2
RAID volume 2
recovery drive 2
reliability 2
stripe 2
striping 2
RAID volume 2, 6, 11, 29
recovery drive 2, 3, 10, 21, 25, 27, 29
reliability 2
resetting RAID drives to non-RAID 27

S
SATA drives 6
simplified migration 10
stripe 2, 3
striping 2, 5
supported devices 6
supported operating systems 6
supported RAID modes 3

30 Index